
Preface 

About SunFounder 

SunFounder is a technology company focused on Raspberry Pi and Arduino open source 

community development. Committed to the promotion of open source culture, we strive to 

bring the fun of electronics making to people all around the world and enable everyone to 

be a maker. Our products include learning kits, development boards, robots, sensor modules 

and development tools. In addition to high quality products, SunFounder also offers video 

tutorials to help you build your own project. If you have interest in open source or making 

something cool, welcome to join us! Visit www.sunfounder.com for more! 

About the Smart Car Kit V2.0 for Arduino  

This smart car can go forward and backward, and turn left and right. Controlled by the 

SunFounder Uno board, it can realize IR remote control, line following, hand following, 

obstacle avoiding, etc.   

This car kit is a great platform for you to get started with robotics. After assembling the car 

based on the instructions in this booklet, you will learn how to operate the smart car through 

6 experiments corresponding to the aforementioned movements. Furthermore, you can 

extend more functions or build your own robot based on what's learnt. 

Note:  

Go to LEARN -> Get Tutorials -> Smart Car Kit V2.0 for Arduino on our website 

www.sunfounder.com to view the related code and other materials. Please read this manual 

carefully before experiment. You are suggested to follow this guide to assemble the smart 

car model and carry out each experiment taking the wiring steps with diagrams. Then, with 

the knowledge needed, you may be able to DIY another car!  

Free Support 

If you have any TECHNICAL questions, add a topic under FORUM section on our 

website and we’ll reply as soon as possible.  

For NON-TECH questions like order and shipment issues, please send an email to 

service@sunfounder.com. You’re also welcomed to share your projects on FORUM. 
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Components List 

Acrylic Plate 
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Mechanical Fasteners 

Component Name Qty. 

 M1.5*8 Screw 6 

 
M3*12 Countersunk Screw 4 

 
M3*6 Screw 18 

 
M3*8 Screw 40 

 
M3*10 Screw 10 

 
M3*28 Screw 6 

 
M4*10 Screw 8 

 
M4*20 Screw 4 

 
M3*10 Copper Standoff 16 

 
M3*13 Copper Standoff 6 

 
M3*25 Copper Standoff 6 

 
M3*30 Copper Standoff 4 

  
M3*35 Copper Standoff 4 

 
M4*30 Copper Standoff 4 

 M1.6 Nut 6 

 
M3 Nut 17 

 
M4 Nut 4 

 
M3 Self-locking Nut 2 

 
M4 Self-locking Nut 4 
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F694ZZ Flange Bearing 4 

Power Accessories 

Component Name Qty. 

 

Tower Pro MG995 Micro Servo 1 

 

Gear Motor 2 

 

Driven Wheel 2 

 

Driving Wheel 2 

Electronic Accessories 

Component Name Qty. 

 

SunFounder Uno 1 
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Sensor Shield 1 

 

DC Motor Driver Module 1 

 

Step-down DC-DC 

Converter Module 
1 

 

Switch Module 1 

 

HC-SR04 Ultrasonic 

Module 
1 

 

Line Follower Module 1 

 

IR Receiver Module 1 
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IR Remote Controller 1 

 

18650x2 Battery Holder 1 

 

Ribbon (13cm) 2 

 

USB Data Cable (1m) 1 

 

12cm Male-to-Male 

Jumper Wire 
6 

 
10cm Male-to-Female 

Jumper Wire 
2 

 
10cm Female-to-Female 

Jumper Wire 
10 

 

25cm 3-pin Anti-reverse 

Cable  
1 

 

25cm 4-pin Anti-reverse 

Cable 
2 

Tools 

Component Name Qty. 

 
Cross Screwdriver 1 

 

Cross Socket Wrench 1 
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Heat Shrink Tube 1 

Self-provided Components 

The following components are not included in this kit. 

Component Name Qty. 

 

18650 3.7V Rechargeable Li-

ion Battery 
2 

Note: 

1. You are recommend to use 18650 batteries without a protective board. Otherwise, the 

car may be cut power and stop running because of the overcurrent protection of the 

protective board.  

2. For unprotected batteries, please purchase those with the anode bulged out (as shown 

below), so that it can ensure the well connection with the battery holder. 

    

3. If you only have batteries with the protected board, it’s ok. To use it, you can remove the 

board on the cathode. But you should operate with care to avoid any hurt; Since the 

metal shell is connected to the cathode for most batteries, please don’t use screw driver 

or other metal objects to remove, or the battery may get shorted and be burnt if the shell 

is connected to the positive pole accidentally.  
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Introduction to the Smart Car V2.0 for Arduino 

The smart car is a great platform for you to get started with robotics. According to the 

instructions in this manual, you will learn not only how to assemble a robot car but also play 

the smart car through 6 experiments. After mastering every experiment, you can extend its 

functions or build your own platform based on our smart car platform.  

 

With the modules and sensors added, the smart car can go forward, go backward, and turn 

left and right. Besides, it can realize IR remote control, line following, hand tracking, obstacle 

avoidance, etc. Many boards and sensors are used in this project such as the sensor shield, 

motor driver module, step-down DC-DC converter module, switch module, ultrasonic 

ranging module, photosensitive module, obstacle avoidance module, and line follower 

module. Different modules are used to achieve corresponding functions. And the car is 

controlled by SunFounder Uno board. Next let's first check these modules in detail. 
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Get Started 

Note: 

Before starting your own project, you must download the Smart_Car_V2.0_for_Arduino.zip 

package on our website by visiting LEARN -> Get Tutorials -> Smart Car Kit V2.0 for Arduino 

and unzip it. 

Arduino 

Description 

Arduino is an open source platform that applies simple software and hardware. You can get 

it in a short even when you know little of it. It provides an integrated development 

environment (IDE) for code editing and compiling, compatible with multiple control boards. 

So you can just download the Arduino IDE, upload the sketches (i.e. the code files) to the 

board, and then you can see experimental phenomena. For more information, refer to 

http://www.arduino.cc.  

Arduino Board – SunFounder Compatible 

In this kit, the SunFounder Uno R3 board is used and it is completely compatible with Arduino 

Uno Board. 

  

  

Sun
Fou

nd
er

http://www.sunfounder.com/learn/download/U21hcnRfQ2FyX2Zvcl9BcmR1aW5vLnppcA==/dispa
http://www.arduino.cc/


 

9 

Install Arduino IDE 

The code in this kit is made based on Arduino, so you need to install the IDE first. Skip it if you 

have done this.  

Step 1: Go to the arduino.cc website and click Software. On the page, check the software 

list on the right side under Download the Arduino Software.  

 

Find the one that suits your operation system and click to download. There are two versions 

of Arduino for Windows: Installer or ZIP file. You're recommended to download the former. 

Step 2: Double click the .exe file and the following window will show up. Click I Agree. The 

following interface will show up. 

  

Sun
Fou

nd
er



 

10 

 Next. 

 

Click Browse to choose the installation path or enter a directory at the Destination Folder. 

Click Install. 

 

The following interface will show up. (After the installing progress bar goes to the end, the 

Close button may be enabled for some PC. Just click it to complete the installation.) 
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Then a prompt appears. Select Always trust software for "Adafruit Industries" and click Install. 

 

Select Always trust software for "Arduino srl" and click Install. 

 

After the installation is done, click Close. Then an Arduino icon will appear on the desktop:  
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Add Libraries 

1) Select Sketch -> Include Library -> Add ZIP Library. 

  

2) Find the file MsTimer2.zip under Smart Car V2.0 for Arduino\Code\Library. Click Open. 

 

3) Similarly, add IRromte.zip and NewPing.zip under Smart Car V2.0 for 

Arduino\Code\Library to library. 

 

4) Then you'll be prompted by Library added to your libraries. Check "Import libraries". You 

also can see the libraries just imported have appeared on the list by going to 

Sketch->Include Library->MsTimer2.  
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Sensor Shield 

It is convenient to place components on a breadboard. However, you need to have some 

electronic foundation to build various kinds of circuit. By using this sensor shield, you only need 

to wire components to the shield with some jumper wires, and then you can build your own 

project quickly. The sensor shield is one of the most common Arduino peripheral devices, as 

shown below: 
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Its schematic diagram is as shown below: note that VCC only supplies power to the devices 

connected to D2 (hooked to the black servo) and D3. Other components are powered by 

5V. 
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Motor Driver Module 

The motor driver module is used to drive two motors to rotate. The driver chip used here is 

L298N. 

 

Its schematic diagram is as shown below: 
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L298N is a high voltage, large current driver chip manufactured by ST, which uses a 15-pin 

package.  

Its main features are as follows:  

• High operating voltage, which can be up to 40 volts.  

• Large output current - the instantaneous peak current can be up to 3A.  

• With 25W rated power.  

• Two built-in H-bridge, high voltage, large current, full bridge driver, which can be used to 

drive DC motors, stepper motors, relay coils and other inductive loads.  

• Using standard logic level signal to control.  

• Able to drive a two-phase or four-phase stepper motor, and two-phase DC motors. 

 

Its pin functions are as shown below: 

Pin Name Description 

1 

15 

Sense A 

Sense B 

The sense resistor is connected between this pin and ground to 

control the current of the load. 

2 

3 

Out 1 

Out 2 

Outputs of the Bridge A; the current that flows through the load 

connected between these two pins is monitored at pin 1. 

4 Vs 

Supply Voltage for the Power Output Stages. 

A non-inductive 100nF capacitor must be connected between this 

pin and ground. 

5 

7 

Input1 

Input2 
TTL Compatible Inputs of the Bridge A. 

6 

11 

Enable A 

Enable B 

TTL Compatible Enable Input: the L state disables the bridge A 

(enable A) and/or the bridge B (enable B). 

8 GND GND 

9 Vss 
Supply Voltage for the Logic Blocks. A100nF capacitor must be 

connected between this pin and ground. 

10  

12 

Input3 

Input4 
TTL Compatible Inputs of the Bridge B. 

13 

14 

Out 3 

Out 4 

Outputs of the Bridge B. The current that flows through the load 

connected between these two pins is monitored at pin 15. 
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The driver module can drive two motors. The enable terminals ENA and ENB are effective at 

high level. The control mode (high/low level) and state of motor A are as shown below: 

ENA IN1 IN2 State of Motor A 

0 X X Stop 

1 0 0 Brake 

1 0 1 Rotate clockwise 

1 1 0 Rotate counterclockwise 

1 1 1 Brake 

If you want to regulate the speed of motor A by PWM, you need to set IN1 and IN2, confirm 

the rotational direction of the motor, and then output PWM pulses for enabled terminals. 

Please note that the motor is in the free stop state when the signal of enabled terminal is 0. 

When the enabled signal is 1, if IN1 and IN2 are 00 or 11, the motor is in brake state, and the 

motor stops rotating. If IN1 is 0 and IN2 is 1, the motor A rotates clockwise; if IN1 is 1 and IN2 is 

0, the motor A rotates counterclockwise. This is the control method for motor A. The control 

method for motor B is the same as that for motor A. 

Step-down DC-DC Converter Module 

 

The DC-DC module is used to reduce the input voltage and output a stable 5 volts voltage. 

Here the LM2596 switching voltage regulator is used to regulate the voltage.  
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The corresponding schematic diagram: 

 

The LM2596 regulator is a monolithic integrated circuit ideally suited for easy and convenient 

design of a step−down switching regulator (buck converter). It is capable of driving a 3.0A 

load with excellent line and load regulation. It is internally compensated to minimize the 

number of external components to simplify the power supply design.  

Since LM2596 converter is a switch−mode power supply, its efficiency is significantly higher in 

comparison with popular three−terminal linear regulators, especially with higher input 

voltages. The LM2596 operates at a switching frequency of 150 kHz thus allowing smaller sized 

filter components than what would be needed with lower frequency switching regulators. It 

is available in a standard 5−lead TO−220 package with several different lead bend options, 

and D2PAK surface mount package.  

Features  

• Fixed Output Voltage: 5V 

• Guaranteed 3.0 A Output Load Current  

• Wide Input Voltage Range up to 40 V  

• 150 kHz Fixed Frequency Internal Oscillator  

• TTL Shutdown Capability  

• Low Power Standby Mode, typically 80 μA  

• Thermal Shutdown and Current Limit Protection  
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Its pin functions are as shown below: 

Pin Name Description 

1 VIN 

This is the positive input supply for the IC switching regulator. A suitable 

input by pass capacitor must be present at this pin to minimize voltage 

transients and to supply the switching currents needed by the 

regulator. 

2 GND Circuit ground 

 

3 

 

OUTPUT 

Internal switch. The voltage at this pin switches between (+V IN − V 

SAT) and approximately −0.5V, with a duty cycle of approximately V 

OUT /V IN. To minimize coupling to sensitive circuitry, the PC board 

copper area connected to this pin should be kept to a minimum 

4 Feedback Senses the regulated output voltage to complete the feedback loop 

5 ON/OFF 

Allows the switching regulator circuit to be shut down using logic level 

signals thus dropping the total input supply current to approximately 

80 µA. Pulling this pin below a threshold voltage of approximately 1.3V 

turns the regulator on, and pulling this pin above 1.3V (up to a 

maximum of 25V) shuts the regulator down. If this shutdown feature is 

not needed, the ON /OFF pin can be wired to the ground pin or it can 

be left open; in either case the regulator will be in the ON condition 

Switch Module 

 

The switch module is used to turn on/off the power. A self-locking switch is used. It is a single-

pole double-throw switch. When the button is not pressed, pin 1 and 3 are connected, and 

pin 4 and 6 are connected, as shown in figure (a). When the button is pressed, pin 2 and 3 

are connected, and pin 4 and 5 are connected, as shown in figure (b). 

Sun
Fou

nd
er



 

20 

 

                                             

  (a) When the button is NOT PRESSED      (b) When the button is PRESSED 

Ultrasonic Module HC-SR04 Distance Sensor 

 

The ultrasonic ranging module HC-SR04 provides 2cm-700cm non-contact measurement 

function, and the ranging accuracy can reach 3mm. Stable signal can be ensured within 

5m, and signal gradually fades beyond 5m till disappearing at 7m position. 

The module includes ultrasonic transmitters, receiver and control circuit. The basic principle 

of work: 

1) Using IO trigger for at least 10us high level signal; 

2) The module automatically sends eight 40 kHz square waves and detect whether there is 

a pulse signal sent back.  

3) If there's a signal sent back, output a high level through pin ECHO; the time duration is 

the time from sending the ultrasonic to the returning.  

Thus, test distance = (high level time × velocity of sound (340M/S) / 2. 

The timing diagram is as shown below. You only need to supply a short 10uS pulse to the 

trigger input to start the ranging, and then the module will send out an 8-cycle burst of 
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ultrasound at 40 kHz and raise its echo. The echo is a distance object that is pulse width and 

the range in proportion .You can calculate the range through the time interval between 

sending trigger signal and receiving echo signal. Thus,  

uS / 58 = centimeters or uS / 148 =inch; or: the range = high level time * velocity (340M/S) / 2; 

You're recommended to use over 60ms measurement cycle, in order to prevent conflicts 

between trigger signal and echo signal. 

 

Line Follower Module 

 

The TCRT5000 infrared photoelectric switch adopts a high transmit power infrared 

photodiode and a highly sensitive phototransistor. It works by applying the principle of 

objects' reflecting IR light – the light is emitted, then reflected, and sensed by the synchronous 

circuit. Then it determines whether there exists an object or not by the light intensity. It can 

be used to easily identify black and white lines. 

In other words, the different conduction levels of the phototransistor when it passes over 

black and white lines can generate different output voltages. Therefore, all we need to do 

is to collect data by the AD converter on the STM8S105C4 and then send the data to the 

master control board via I2C communication.  
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This module is an infrared tracking sensor one that uses a TRT5000 sensor. The blue LED of 

TRT5000 is the emission tube and after electrified it emits infrared light invisible to human eye. 

The black part of the sensor is for receiving; the resistance of the resistor inside changes with 

the infrared light received. 

Supply Voltage: 5V; PCB Dimensions: 124 x 30 mm 

IR Receiver Module 

 

The infrared-receiver module uses the HS0038B as the infrared receiving head which receives 

infrared signals and can independently receive infrared ray and output signals compatible 

with TTL level. It's similar with a normal plastic-packaged transistor in size and it is suitable for 

all kinds of infrared remote control and infrared transmission. 

Features 

• High protection ability against EMI. 

• Circular lens for improved reception characteristics. 

• Line-up for various center carrier frequencies. 

• Low voltage and low power consumption. 

• High immunity against ambient light. 

• Photodiode with integrated circuit. 

• TTL and CMOS compatibility. 

• Long reception distance. 

• High sensitivity. 

• Pb free and RoHS compliant. 

Servo 

Servo is a set of automatic control system composed of DC motors, reduction gear set, 

sensors and control circuits. The output shaft can be rotated to a certain angle by sending 

signals. The servo can only rotate in a certain range, for example, 0-180°. It cannot rotate in 
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circle continuously like DC motor. The servo enables you to easily rotate an object in a certain 

angle, so it is widely used in model planes and robot joints. 

Only the MG995 SG90 Micro Servo is used in this kit, which is assembled on the front chassis 

of the car for steering structure. 
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Car Assembly 

Front Wheels 

1. Fasten the bearing, the following acrylic plates and driven wheel with an M4*20 screw 

and an M4 self-locking nut. Tighten the screws with the Cross Socket Wrench and the 

Cross Screwdriver. 

 

2. After assembly, it is as shown below: 

 

3. Do not over tighten the nuts so that the 

wheel can spin smoothly. 
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Deflecting Plate + Front Wheels 

1. Fasten the following acrylic plates and the assembled front wheel with M3*8 screws 

and M3*13 copper standoffs. And fasten an M3*8 screw and an M3*35 copper 

standoff to the smaller acrylic plate. 

 

2. After assembly, it is as shown below: 
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3. Connect another front wheel, as shown below: 

 

Note: After assembly is done, rotate the two wheels. If they cannot spin smoothly, loosen 

the M4 nuts with the wrench and the screwdriver. 

Deflecting Plate + Rocker Arm 

1. Fasten the following rocker arm of the SG90 servo to the deflecting plate with servo 

screws.  

Packaged with the servo, the servo screws are within the longer four of five screws. 

The rocker arm is packaged with the servo together. 
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2. After assembly, it is as shown below: 

 

Note: The screw is quite sharp at the end, so be careful to assemble in case of getting 

hurt. 

Rear Lower Plate + Rear Wheels 

1. Assemble the following acrylic plates together. 

 

2. After assembly, it is as shown below: 
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3. Fasten the following acrylic plates and gear motor with M3*28 screws and M3 nuts. 

Assemble the driving wheel to the motor. 

 

4. After assembly, it is as shown below: 

 

5. Connect the other driving wheel, as shown below: 
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Deflecting Top Plate 

1. Fasten the following acrylic plates with an M3*10 screw and an M3 self-locking nut. 

Tighten them with the cross wrench and the screwdriver (do not over tighten them).  

 

2. After assembly, it is as shown below: 

Do not over tighten the screws so that the acrylic plate can move smoothly. 

 

3. Mount the IR Receiver module with M3*8 screws and M3 nuts 

 

4. After assembly, it is as shown below: 
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Servo + Chassis + Battery Holder 

1. Fasten the following acrylic plates, the chassis and the servo with M4*10 screws, M4 

nuts and M4*30 copper standoffs. 

Note: You can tell the bottom and upside of the Chassis according to the holes distribution. 

  

2. After assembly, it is as shown below: 

 

3. Fasten the Top Plate with M4*10 screws: 

 

Looking at the upside, 

sparse holes are on 

your right side  
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4. After assembly, it is as shown below: 

 

5. Fasten the acrylic plate for wire organizing to the chassis with an M3*10 screw and an 

M3 nut. 

 

6. After assembly: 
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7. Connect similarly the other 3 acrylic plates symmetrically. 

8.  

9. Fasten the chassis with M3*8 screws and M3*10 copper standoffs. 

 

10. After assembly, it is as shown below. 
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11. Cross the ribbon through the following acrylic plate. Please note that one side of the 

ribbon should be longer and the other is shorter. 

With the ribbon, you can remove the batteries easily. Also you can skip this step.  

 

12. Fasten the chassis and the battery holder with M3*12 countersunk screws and M3 nuts. 

 

13. After assembly it's as follows: 
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Adjust the Servo 

1) Connect the servo to the pin 2 of the sensor shield, and the wiring should be as shown 

below: 

 

 

 

 

Servo 

Brown to GND 

Red to VCC 

Orange to Signal 

(pin2) 

 Power Source 

Red to + 

Black to -

Servo Power 

+  to  VCC 

-  to  GND 
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2) Connect the SunFounder Uno board to your computer via a USB cable. Open the file 

Car_1_Forward.ino under the path Smart Car V2.0 for Arduino\Code\Car_1_Forward. 

Before uploading the sketch to the board, you need to select the right Board and Port 

through Tools -> Board -> Arduino/Genuino Uno. 

 

3) Then click to Tools -> Port -> COM5 (your port may be different) 

 

4) Click the Upload icon. The code is uploaded successfully when you are prompted 

"Done Upload" at the bottom.  

 

5) After uploading the code successfully, you can hear a sound of the gear moving when 

the servo rotates. It means the adjustment succeeds. DO NOT plug out the servo wire 

yet. Keep it power on, and let’s move on to the next step. 

Sun
Fou

nd
er



 

36 

Chassis + Deflecting Plate 

1. Keep the servo power on, fasten the following acrylic plates with M3*8 screws and 

servo screw packaged with the servo among the shorter ones in black. 

Note: The central vertical lines of the Chassis and Deflecting Plate should be 

perpendicular, otherwise the front wheel will not be able to go straight as you control. If 

it’s not well assembled, you should reinsert instead of rotating the servo shaft to adjust, 

since the servo has been calibrated to 90 degrees. If there is just a little deviation from 

the right position of the rocker arm, it can be fine tuned by code. 

 

2. After assembly, it is as shown below: 
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3. The bottom view: 

 

Now, you can remove the servo wires. 

Chassis + Driven Wheels 

1. Fasten the Driven Wheels with M3*8 screws and M3*25 copper standoffs. 
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2. Fasten the Driven wheels and Chassis with M3*8 screws. 

 

3. After assembly, it is as shown below: 

  

4. Mount the following acrylic plate on the car with M3*10 screws and M3 nuts. 
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5. After assembly, it is as shown below: 

 

6. Then assemble the ultrasonic fixing plate to the car with an M3*10 screw and M3 nut. 

 

7. After assembly, it is as shown below: 
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IR Receiver + Ultrasonic + Line Follower 

1. The ultrasonic module with M1.5*8 screws and M1.6 nuts, while the line follower with 

M3*8 screws and M3*30 copper standoffs. 

 

2. After assembly, it is as shown below: 
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Other PCB Assembly 

1. Assemble the DC Motor Driver Module, the Switch Module, the Step-down DC-DC 

Converter Module, and the SunFounder Uno board with M3*6 screws, and then plug 

the sensor shield into the Uno board, as shown below: 

 

2. The assembly should be like this: 
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The top view: 

 

Circuit Building 

1) Connect the motor driver module and sensor shield: 

Motor Driver Module Sensor Shield 

5V 5V 

ENA 5 

INT1 8 

INT2 9 

INT3 10 

INT4 11 

ENB 6 
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2) Connect the motor driver module and two motors: 

 

 

Note:  

Please pay attention to that diagram. Each gear motor has two wiring terminals. You should 

wire them correctly. The wiring will affect the rotational direction of the gear motors. If you 

do not know how to distinguish, you can try wiring them randomly first. Then burn the code 

under the path Smart Car V2.0 for Arduino\Code\ Car_1_Forward to the board to see 

whether the car moves forward. If it does, you've wired them correctly. If not, you may need 

to change the wiring until the car moves forward.  

3) Connect the sensor shield and the servo: 

Servo Sensor Shield 

+ (Red Wire) 5v 

- (Brown Wire) GND 

Signal Output (Orange Wire) 2 
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4) Connect the step-down DC-DC converter module and switch module: 

Note: The two pins of the battery holder should not be in contact; otherwise it will cause a 

short circuit and the battery will be burnt. 

 

5) Connect the IR receiver module and the sensor shield: 

IR Receiver Module Sensor Shield 

SIG (yellow) 7 

GND (black) GND 

VCC (red) 5V 
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The wiring connection is shown as below: 

  

 

6) Connect the line follower module and the sensor shield: 

Line Follower Module Sensor Shield 

GND (black) GND 

VCC (red) 5V 

SDA (yellow) A4 (SDA) 

SCL (white) A5 (SCL) 
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The wiring connection is shown as below: 

  

7) Connect the ultrasonic module and the sensor shield: 

Ensure it's powered off, insert a 4-pin anti-reverse cable to the ultrasonic module, and 

connect the pins as follows: 

Note: Pay attention to the wires. The anti-reverse cable’s red and black wires do NOT 

connect to the anode and cathode!!!  

HC-SR04 Ultrasonic Module Sensor Shield 

GND (white) GND 

VCC (yellow) 5V 

ECHO (red) 12 

TRIG (black) 13 

The wiring connection is shown as below: 
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After the assembly and circuits are finished, if you feel the wires are too messy, you may wrap 

them with the heat shrink tubing so the car can look more adorable with neat wiring. Now 

let's get started!   
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Experiments 

Experiment 1 Going Forward and Backward 

In this experiment, the car begins to walk, but it is just the simplest movements: going forward 

and backward and then stopping. This is the first and most important step for car walking. 

The subsequent experiments are all based on this experiment.  

Experimental Principle 

The batteries output 7.2V to the switch module. When you press the button of the switch 

module, 7.2V will be input to the step-down DC-DC converter module which then outputs 5V 

after lowering the voltage. 5V is input to the sensor shield to supply for the servo. The MG995 

servo at the front is to control the direction the car walks in. In this experiment, the car keeps 

walking straight forward/backward. The motor driver module is used to drive the two gear 

motors connected to the rear wheels of the car, which drive the wheels accordingly. Thus, 

the car begins to walk. 

Experimental Phenomena 

When you press down the button of the switch module, the car starts to go straight. 2 seconds 

later, it starts to go backwards and then stops after another 2 seconds. If you press down the 

button for a second time, the car will start to walk again. If you want to change the time the 

car walks, you can modify the sketch as you like. 

 

Experiment 2 Turning Right and Left  

The principle for this experiment is the same as those for the first experiment. Only a turning 

function is added.  

Experimental Principle 

Change the rotational angle by sketch to make the car turn. 

Experimental Procedures 

Connect the SunFounder Uno board to your computer. Upload the sketch under the path 

Smart Car V2.0 for Arduino\Code\Car_2_Turn, and then remove the USB cable. Press down 

the button on the switch module, and the car will start running.  

Experimental Phenomena 

When you press down the button on the switch module, the car will go forward. 1 second 
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later, it turns right, and then goes forward for 1 second again. Then it turns left. 1 second later, 

the car goes forward for 1 second and then goes backward. Two seconds later, it stops. 

 

Experiment 3 IR Remote Control 

Experimental Principle 

The IR remote control sends data signals, and the IR receiver module receives data signals. 

When a button is pressed, a corresponding string instruction will be sent out from the remote 

controller, and the receiver module would send a signal to turn on the corresponding 

function once it receives the instruction. For example, press 2, and a string will be sent, thus 

the car will just go forward because the string means to drive the car to do so in the code. 

Experimental Procedures 

Connect the SunFounder Uno board to your computer via a USB cable. Upload the sketch 

under the path Smart Car V2.0 for Arduino\Code\ Car_3_Remote, and then remove the USB 

cable. Press the button on the switch module.  

Press the buttons below, and the car will act accordingly: (just press, no need to hold) 

Press a key of the controller  Arduino Smart Car will 

2 Go forward 

8 Go backward 

4 Turn left 

6 Turn Right 

5 Stop 

Experimental Phenomena 
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Experiment 4 Line Following 

Experimental Principle 

The line follower module is an 8-channel IR sensor one. It will send different signals when it 

detects the black line and white surfaces. When a certain sensor detects a black line, the 

corresponding signal will be generated and then passed to the car, thus the car would turn 

its direction accordingly to follow the line by servo rotation. 

Experimental Procedures 

Connect the SunFounder Uno board to your computer. Upload the sketch under the path 

Smart Car V2.0 for Arduino\Code\Car_4_LineFollowing, and then remove the USB cable. 

Pressed the button on the switch module.  

Notes:  

1. If the surrounding is too dark, you can turn on the LED built in the module as shown below (no 

need to turn on normally). 
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2. If the front wheels do not turn when you place the car above the black lines, but it does when 

the module is tilt closer to the line, in other words there signal of black line detection is too 

weak, just adjust the potentiometer below to try. Normally you don't need to adjust. 

 

Now draw a black line on a large white board, start the car and it will go following the line. 

It will stop when no black line is detected, so for better performance you can draw a closed 

path like a number 8-shaped route or a circle. 
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Experiment 5 Hand Tracking 

Experimental Principle 

The principle of this experiment is based on ultrasonic distance measurement. The car 

receives the distance data from the ultrasonic module, and then the program will drive the 

car to take actions according to the code for different distance ranges. 

Experimental Procedures 

Connect the SunFounder Uno board to your computer with a USB data cable. Upload the 

corresponding sketch under path Smart Car V2.0 for Arduino\Code\ Car_5_HandTracking, 

and then remove the USB cable. 

Experimental Phenomena 

Turn on the car, keep your hand moving 0 to 10cm in its front, and then the car will move 

accordingly: looks like you push it, it runs backward when your palm approaches; when your 

hand is 10 to 25cm ahead, move back from the car and it will move forward. When you take 

the hand away, it will stop. Note: The car can only move forward or backward, and cannot 

turn directions in this experiment. 

 

 

Experiment 6 Obstacle Avoidance 

The wiring for this experiment is based on Experiment 5, so after the last experiment, just turn 

it off. Connect the SunFounder Uno board to your computer with a USB data cable. Upload 
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the sketch under Smart Car V2.0 for Arduino\Code\Car_6_AvoidObstacle, and then remove 

the USB cable. 

Experimental Principle 

The principle of this experiment is similar to that of experiment 5, and the difference is when 

it detects an obstacle 30cm ahead, it will turn right to avoid. 

Note: DO NOT increase the car’s speed too much, in case that the sensor in the front may 

be damaged due to great inertial effect upon stop. Besides, the ultrasonic can only detects 

the obstacle in front of the car, that is, the car will turn right every time it detects an obstacle 

30cm in front. 

Experimental Phenomena 

Turn on the switch. When the car detects an obstacle in front (within 30cm), it will turn right 

to avoid it; when there is no obstacle ahead, it will just move forward.  
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Copyright Notice 

All contents including but not limited to texts, images, and code in this manual are owned by 

the SunFounder Company. You should only use it for personal study, investigation, enjoyment, 

or other non-commercial or nonprofit purposes, under the related regulations and copyrights 

laws, without infringing the legal rights of the author and relevant right holders. For any 

individual or organization that uses these for commercial profit without permission, the 

Company reserves the right to take legal action.  
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